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The Silver Wolf Desktop (SWD), from Silver Wolf Software, replaces the standard Windows Program 
Manager interface by bringing more of your computers capabilities to your fingertips. As its name 
implies, the Desktop is designed to make your computer a true extension of your own desk. This 
reference guide has been designed to provide you with everything you need to know about SWD.
Silver Wolf provides technical support through CompuServe and the internet; contact us if you have a 
question, suggestion or when you wish to register. Below are the major topics covered in this guide:

Getting Started

Basic Commands & Features

Keyboard Commands

Mouse Actions, Dragging & Dropping

Menus, Right-Click Mouse (Context) Menus

Projects & Aliases

Windows & Their Contents

Tricks & Tips, Advanced Topics

Macintosh Users

At different points in this document you may find the browse buttons (< and > above) are available. This 
indicates there are related topics that may interest you; an example of this are the menus: File, 
Application, Options, Window, Drives, Help, and Context Menus.
Many of the features provided by SWD are explained in the Glossary section at the end of this 
document. You can use the browse buttons to page through the major sections of this reference just like 
a book, use the links to jump to the page you want, or use the search button to enter key words and 
phrases to find what you need.
Press the ESCape key at any time to quit this help.



Getting Started
SWD displays a brief title bar at the top of your computers screen, your available disk drives (along the 
right edge) and several Command Icons along the bottom of the screen. These command icons include 
a default editor, viewer and print utility. You can drag & drop files (and, in the case of the trashcan, whole
directory folders) onto each of these icons.
Each physical DOS directory is represented as a window containing other folders (subdirectories) and 
files. These items can be displayed as icons with text, text only, and buttons (no text; called a button 
bar). You can also control how they are sorted as from the Options menu.

Installation
The SW Desktop is released in two ways: 1) for electronic distribution and 2) on diskette. The former 
method contains the core software necessary to evaluate SWD for your purposes while minimizing your 
download time in a PKZIP v2.04g zip file. The diskette release contains some additional utilities and 
uses a setup program to install the SW Desktop on your computer.

Zip File Installation
Create a directory on your hard disk where the SW Desktop files will reside. We recommend C:\SWD 
but you can choose whatever name you wish. Unzip the files into the directory using PKUNZIP; for 
example:

PKUNZIP    SWD12    C:\SWD

Change into the directory (CD \SWD) and create a subdirectory called STARTUP (MD STARTUP).
You are now ready to use the SW Desktop. Skip to the Running SWD section (below).

Diskette Installation
If you have the diskette release of the Silver Wolf Desktop, you need to run the SETUP.EXE program 
found on the diskette from within Windows 3.1. From the Program Manager, choose the File | Run menu
and enter A:\SETUP.EXE (or B: as appropriate) and follow the instructions.
The SW Desktop can be installed in any directory name you choose but the setup will prompt you with 
our recommendation. Other questions may be asked including if you want to create a Program Manager 
group for the SW Desktop and related files.

Running SWD
Once the installation is complete, you can run SWD.EXE from either the File | Run menu of Program 
Manager or from within File Manager. This is the quickest way to begin evaluating and using the SW 
Desktop.

Automatically Starting SW Desktop from Program Manager
By defining SWD.EXE in Program Managers Startup group initiates the Silver Wolf Desktop whenever 
Windows 3.1 is brought up while ensuring Program Manager itself is still readily available.

Replacing Program Manager
By changing the shell= line in SYSTEM.INI you can replace the    Windows 3.1 Program Manager 
(PROGMAN.EXE) with the Silver Wolf Desktop (SWD.EXE). You should include the entire path where 
the SW Desktop is located; for example:

Shell=C:\SWD\SWD.EXE

Other than the two situations mentioned above, SWD does not modify your DOS or Windows 
configuration files (eg: autoexec.bat, config.sys, win.ini, etc). The Desktop changes the way you use 
your computer, not your computers configuration.
If the SW Desktop is installed as the Windows 3.1 shell, any WIN.INI entries for the load= or run= 
commands will be processed. Otherwise, SWD leaves that responsibility to Program Manager.



Startup Directory
The STARTUP subdirectory, if found within the SWD install directory, will be examined by the SW 
Desktop as it is initializing. Any files found within the Startup directory will be run, any directories will be 
opened so its contents are displayed on the desktop, and any aliases -- of files or directories -- will be 
traced back to their source and that file will be run or the directory opened.



Configuring the Desktop
The SW Desktop is configured using the Options | Edit Preferences command. This menu 
choice will only appear if SWD finds the program, CONFIG.EXE, in the same directory with 
the SW Desktop. If this menu choice does not appear, you can manually edit the SWD.INI 
file using the Options | Edit SWD.INI command.

Edit Preferences
The CONFIG.EXE program presents check boxes of on/off options, lists of values, colors, 
registration information, and fill-in-the-blank fields corresponding to the various reference 
information stored in the SW Desktops initialization file, SWD.INI.
As you select each option a brief description appears in the lower portion of the window to explain what 
the option will do or how it may affect how the SW Desktop will act. The Colors and Registration 
information are found on the Edit menu (the Colors options also rate a button on the main window).
The File menu allows you to save the options in another file you name, reload the options from the 
saved file, open another SWD.INI compatible file, set Config-specific options (Preferences), and exit the 
configuration utility.
Currently, there is only one option for the Configuration utility itself; Clean Ini, which clears out each 
section of SWD.INI as the information is written back to the initialization file. This option is reset (off) by 
default but can be useful if you want all comments or extraneous option settings removed from the 
initialization file. The setting of this option is not saved between runs of the configuration utility.
If the configuration utility recognizes you have changed any options, it will ask permission to restart 
SWD to affect the changes.



Changing the Desktop
The SW Desktop stores the current configuration in the SWD.INI Windows initialization file. This file is 
located in the same directory with the SWD.EXE file. You can also use the Options | Edit Preferences 
menu command to bring up the SW Desktop Configuration (SW Config) utility. SW Config presents 
several groups of check boxes, lists and other information which controls how the SW Desktop looks 
and acts.

Options
A major part of the SW Desktops function allows you to do what is called file management. File 
management is simply copying, moving, deleting, etc files. Since these options change the information 
on your computer, you may want some reminders to let you know when a serious change may be taking 
place. For that reason a number of options exist to ask your permission to perform these actions; they 
include:

Confirm Alias asks your permisssion before creating any aliases.

Confirm Copy asks permission before copying any item or group of items from one directory or disk
to another. If a group of items is being copied, you will only be asked the question once.

Confirm Delete asks permission before removing any item or group of items from the disk. In the 
SW Desktop, delete indicates you have pressed the DEL key or selected Delete from a menu. 
Deleting a file or directory is immediate.

You will also be asked permission to trash any item or group of items. Trashing a file or directory 
simply moves it into the \TRASH directory for that disk; no disk space is freed up until you select 
Empty Trash from the Trashcans menu.

If you are deleting or trashing a group of items, you will only be asked the question once. Since a 
directory contains information you will also be asked to confirm the action against the directory 
and its contents separately.

Confirm Move asks permission before moving a item or group of items from one directory or disk to 
another. If a group of items is being copied, you will only be asked the question once.

Confirm Overwrite asks permission when a file of the same short (DOS) name exists in the 
destination directory. You will be asked this question for each file where this situation exists. 
Overwriting means the file in the destination directory will be removed so the copy or move can 
continue.

This question may be asked in addition to any confirmations required by the Confirm Copy or 
Confirm Move options.

Confirm Sys Files asks permission before performing an operation, such as copy or move, with a 
file where the Hidden, System, and/or Read-Only file attributes are set. Hidden files are simply 
not visible in a DOS dir list. System files are operating system files and extreme care should be 
taken before copying or moving these files. This option is called ConfirmHSR in the initialization 
file.

Due to the finality of some commands, a number of non-file related confirmations also exist to control 
how the SW Desktop act. These options are all the result of File menu commands.

Confirm Restart Windows asks if you really meant to restart Windows 3.1. Selecting the File | 
Restart Windows menu command will close all applications and restart Windows.

Confirm Reboot System asks if you really want to reboot your computer. This action is usually a 
severe choice under unusual circumstances or where you have changed the AUTOEXEC.BAT or 
CONFIG.SYS files and need to affect the changes. Command: File | Reboot System.

Confirm Exit Windows asks if you really want to shut down Windows. Command: File | Exit 



Windows.

Confirm Exit SWD asks if you really want to shut down the SW Desktop. If you have replaced 
Program Manager with SWD as your Windows shell, the File | Exit SWD command will not 
appear.

General options include:
Show Windows Resources in Titlebar adds the current Windows resources to the title bar of the 

SW Desktop. With this option checked, you can easily see the impact of running additional 
applications; when memory or other resources are becoming scarce.

Display Startup Status Messages lets you see what SWD is doing as it initializes. These 
messages are displayed on the splash screen that displays when the SW Desktop is starting. 
Resettiing this option still displays the splash screen, but no messages are displayed.

Minimize Other Applications on Startup, when set, tells SWD to minimize any running 
applications into icons as it initializes. When reset, other applications are not affected by the SW 
Desktops initialization.

Minimizing other applications does not terminate or otherwise affect what they are doing; it simply
clears your computers desktop area.

Allow Desktop to be Minimized places a minimize button at the top right of the SW Desktops title 
bar. When the desktop is minimized, all disk icons, Command icons, and open windows are 
folded into the SWD icon as the desktop itself is minimized.

This option is useful when you run applications such as SmallTalk or Visual Basic which use 
disconnected windows to display various pieces of information.

The Drives section determines which disk drives will be Shown or shown and Checked when SWD 
starts. Disk drives in the Shown list will be placed on the desktop but not initialized. This can be very 
useful for floppy drives. Disk drives in the Checked list will be checked by SWD as it initializes. This 
means SWD attempt to read the disk. If the disk is present its disk label will be displayed under the icon 
for that disk; otherwise, the label will show the drive letter followed by (no disk). Disk drive icons are 
explained further under Drives Menu.
The Update Drives button will clear the two lists and add all currently valid disk drives to the Checked 
list. You can then move individual drives to the Shown list (or back again later) by double-clicking on the 
drive letter or selecting one of the direction buttons. The single arrowhead buttons move the currently 
highlighted drive to the other list (in the direction the arrowhead is pointing). The double arrowheads 
move all drives in the list into the other list.

The Command Icons section defines the applications to display at the bottom of the desktop. These 
icons are called Command Icons since they perform some action, a command. The SW Desktop comes 
pre-configured for three default Command Icons: edit, print, and view.
The edit icon is configured for the Windows NotePad text editor but you can change this to your favorite 
editor. The print and view icons are configured to use two basic applications provided with the SW 
Desktop. The print application provides the ability to print text files while the view application allows you 
to quickly list a file without bringing up the files native application (ie: WinWord, Quattro, etc). When you 
press the enter key to open a file, the view application is activated.
If there is no entry in this list for the trashcan, called trash in the Command Icon list, the default trashcan 
function will be used. To use your own trashcan application, define an entry in this list for trash pointing 
to your application. Pressing the INSert or DELete keys will add a new or remove Command Icons from 
the list; pressing F2 allows you to edit an exiting entry.

Colors
The SW Desktop uses the standard Windows 3.1 configured colors to display text and other parts of the 
desktop with two exceptions: the directory window background color and the list window background 



color. These two window types use different background colors to provide a quick visual cue as to when 
you can change the contents of the window. List windows are read-only; meaning you cannot add files 
or directories to the window. You can, however, open files and update them. Deleting an item from a list 
window merely removes the item from the list; no file is removed from the disk.
Examples of list windows include results from the File | Find command, the Window | History List 
window, the Window | Program Manager Groups window, the Window | Registered Applications window, 
and .ZIP files.

Fonts
The SW Desktop uses one font family to display text on the desktop. This one font family, Arial by 
default, uses different attributes to display different items on the desktop: files are normal, directories are
bold, and aliases are italicized.
There are two types of display, called views, which may require different sized text to make the 
information more readable. These two types are called Icon View and the Text Views (Text-only and Text
& Info). The Icon View font size controls the text displayed under an icon while the two Text Views 
display text in a list format.

Registration
This section simply allows you to update the registration information.



SW Desktop Files

SWD.EXE The Silver Wolf Desktop executable codefile.
SWD.INI Windows initialization file containing option settings 

across runs of SWD.
SWD.HLP Extensive, detailed help about the capabilities and 

features of SWD.
DEFAULT.DT The default window/folder layout to use when SWD 

initializes. Other .DT files may be created from the File | 
Save Desktop As menu choice. This file is not required; if 
it is not present, no windows will be opened.

DEFAULT.HST The history list. If this file is removed, SWD will begin 
create a new one as you begin running files and 
programs.

CTL3D.DLL A dynamic link library needed by SWD. This file is 
installed in the same directory with the SWD.EXE 
codefile.

DOSCMD.PIF Used by SWD to execute DOS commands such as Label 
or Format.

README.TXT Contains last minute notes and hints about installing and 
using this software.

VIEW.EXE The Silver Wolf Viewer (SWV) is the default viewer if no 
application is associated with the file being launched or 
run. This viewer presents the contents of a file in simple 
text, hexadecimal and in a combined hex and text view. 
This combined view shows the hex on the left of the 
window and any ASCII text to the right. Non-printable 
characters are shown as periods (.).

PRINT.EXE The Silver Wolf Printer (SWP) is the default printer if no \
shell\print\command has been installed for the file being 
launched or run.

CONFIG.EXE The SW Desktop is configured using this application. All 
permanent options are presented.

VBRUN300.DLL Since Config.EXE is written in Visual Basic, this library 
must be installed.

THREED.VBX This library provides 3-D look & feel to Config.EXE.

Basic Commands & Features
Some of the more common commands and features are described below. These are only the more 
commonly used commands and features; more detail can be found in the standard SWD help.
Copying a file or directory can be done in one of two ways with the mouse. If you click-

drag the item (file or directory icon) from one disk to another, the item will be copied. If 
you want to copy an item to another location on the same disk you need to press the ctrl 
key while dragging the item to its new location. Remember to hold the ctrl key down until
after you drop the item.

Moving a file or directory is accomplished by dragging a file from one directory to another 
on the same disk.

Renaming a file or directory is as easy as bringing up the Properties dialog for the item 



entering a new name; selecting OK makes the change. The Properties dialog can be 
brought up using alt-enter or right-click and choosing Properties while the item is 
selected.

Deleting a file or directory can be accomplished in two ways: 1) dragging the item to the 
trashcan or, 2) pressing the delete (DEL) key. Dragging the item to the trashcan really 
moves it to the \TRASH directory of that disk allowing to pull something out of the trash 
is necessary (select open from the trashcans popup menu). The trashcan can then be 
emptied when you need more free space on the disk.

Pressing the delete key removes the item from the disk immediately.
Running an application or opening a file. Pressing enter or double-clicking a file will either

run that program or attempt to find an appropriate program to run for the selected file. 
So, if you try to run CARDFILE.EXE, the Desktop will run that program. But, if you try to 
run XMAS.CRD, the Desktop will look for an associated program (in this case, 
CARDFILE.EXE) and run it with the selected file as input. Not all programs recognize this 
type of run request.

Pressing alt-R will run the selected application, prompting you for additional parameters 
such as the name of a file, command-line options, etc.

Creating Aliases for files and directories can put a frequently used application in a single 
directory for easy access without moving the actual codefile or reinstalling the 
application, help manage projects for work by bringing different files together, etc.

Command Icons provide a quick way to run certain applications you find important. These
icons appear at the bottom of the Desktop. Two pre-defined command icons include the 
trashcan and default editor (usually a text editor). Seel also: Command Icons section.

The Properties dialogs allow you to change the item (file or directory) name, create a long
name, add additional parameters or a working directory to a program. It also shows you 
the date/time of the file, its size, associated icon, etc.

Disk Icons make your disk drives available right on the Desktop. CD-ROM and network 
drives are also supported.

Finding Files across the disk can be difficult but SWD provides a very powerful search 
capability to help. From the File pull-down menu select Find and enter the criteria for the 
search. If you ask SWD to search for Windows applications, be prepared to wait as this 
operation can take a while (the results, however, can be well worth the wait).

The History List maintains a list of the most recently used programs and files. The list 
which appears in the Applications pull-down menu is limited to ten (10) items while the 
History List window (from the Window menu) can show more. To remove an item from the
list, simply press the delete key; it removes the item from the list, not the disk.

You can Save the Desktop layout or several layouts to quickly open related windows on 
the SW Desktop. For example, you might create one desktop layout for your business 
related folders and another for your personal finances. Simply opening a different 
DeskTop (.DT) layout clears the desktop of all open folders (while not affecting any 
running programs) and opens the window folders defined in the new layout.



Keyboard Commands
The SW Desktop is a Windows 3.1 application which follows the standards for keyboard usage. This 
means that any time you see an underlined character on a menu or dialog box, you may press the alt 
key and that letter to either go to that command or field. SWD, however, also provides a number of 
additional commands which are outlined below:

<letter> Pressing any letter when a list or directory window is open will move
to the next item in the window which begins with that letter, if any. 
The selected item will be highlighted (see shift-arrow keys to select 
more than one item).

arrow keys,
pgup, pgdn,
home, end

These various keys allow you to move around the windows, moving 
the selection as you go. If the shift key is pressed while pressing any
of these keys you can select multiple Items for some action (eg: 
copy, move, delete).

shift-arrow Pressing the shift key while using any of the arrow keys will select 
additional items in the window. Any action, such as dragging and 
dropping will be performed on all of the selected items.
Equivalent mouse action: click-drag.

enter Opens the selected item (folder, file, etc). List and Directory Folder 
items will be opened and their contents displayed. File items will be 
run based on the files type and/or file association; thus, an 
executable will be run or the files associated program will be run. If 
there is no association for a file item, the default viewer will be used 
to examine the file. This is the same as double-clicking the item. See
also: alt-R.
Equivalent mouse action: double-click on the icon (or filename in a 
text list).

alt-enter Brings up the Properties for the selected item. This is the same as 
right-click | Properties. The Properties menu allows you to change 
the items name, the long name and any additional parameters to be 
included when the item is run.
Equivalent mouse action: double-click on the text under an icon.

spacebar Brings up the Context Menu for the item.
Equivalent mouse action: right-click.

shift-spacebar Toggles the selection of an item from on to off (or off to on) when 
selecting multiple items.
Equivalent mouse action: shift-click.

backspace Opens the parent directory of the current directory window but does 
not create a new window (the parent directory replaces its child in 
the same window). See also: ctrl-backspace.

del Deletes the selected item (file or directory). If the selected Item is a 
member of a list window (ie: the History List), the entry is simply 
removed from the list.
If the ConfirmDelete option is set you will be asked to confirm this 
action before anything is removed from disk. This option is set by 
default.
This action causes the file to be immediately removed from the disk 
while dragging a file or folder to the trashcan simply moves the item 
into the \TRASH directory for later removal.

esc Closes the currently open window. If the SW Desktops menu bar, or 



one of the disk or command icons is active you will be asked if you 
want to exit SWD (as if you had pressed alt-F4).

alt-1 Display the current window as Icons -- icons with the filename 
underneath (the initial default). See Options | Default View for more.

alt-2 Display the current window as Text only -- only show the short 
(DOS) filename.

alt-3 Display the current window as Text & Info -- the filename, size, 
date/time, long name, etc.

alt-4 Display the current window as Buttons -- only shows the icon on a 
button. See the Advanced Topics to learn how to create and use a 
button bar.

alt-D Opens a DOS session in the most recently active directory window. 
This command also appears on the Applications | DOS Shell menu.

alt-R Runs the item, prompting for additional command-line parameters 
first. See also: enter.

alt-F4 Exits the SW Desktop. You can also terminate SWD using the File | 
Exit SWD command.

ctrl-enter Opens the selected directory or file, replacing the currently active 
window with the new window or application. If, for example, the 
currently selected item is a directory folder and you press ctrl-enter 
the current window will be closed and replaced by the selected 
directory. If the item is a file or application, the SW Desktop will 
attempt to run the associated application or the application itself.

ctrl-<letter> Opens the root directory of the disk drive represented by <letter>. 
Thus, you can quickly open the root folder for drive D by entering 
ctrl-D.
Equivalent mouse action: double-click on the appropriate disk icon 
along the right side of the desktop..

ctrl-tab Moves through the list of open windows, Command Icons, and disk 
drives similar to the way alt-tab moves you to different running 
applications in Windows. See also: ctrl-shift-tab.

ctrl-shift-tab Moves backward through the list of open SWD windows, Command 
Icons, and disk drives. See also: ctrl-tab.

ctrl-esc Brings up the Windows 3.1 Task List dialog.

Mouse Actions
Many action you can do with the mouse have keyboard equivalents or commands on menus to 
accomplish the same thing.

click Pressing the left mouse button once over an item selects it.
Equivalent keyboard command: home, end, arrow keys.

Pressing the shift key while clicking on the item allows you to select 
more than one item.
Equivalent keyboard command: shift-arrow keys.

shift-click Toggles the selection of an item from on to off (or off to on) when 
selecting multiple items. See also: click-draw.



Equivalent keyboard command: shift-spacebar.
double-click Clicking an item twice (quickly) tells SWD to open that item. If the 

item is a program, it is run. If the item is a folder, it is opened and a 
new window created for it.
If the item is a non-executable file, SWD looks to see if a program is 
associated with the files extension and attempts to run that program.
If there is no program associated with the file suffix, SWD runs the 
default viewer.
Equivalend keyboard command: enter.

double-click
window
background

Double-clicking on the background area of an open window 
refreshes the items -- files and directories -- in the window. For 
efficiency reasons SWD does not always refresh the display so 
double-clicking on the background allows you to update it when you 
want.
Equivalend keyboard action: alt, down-arrow, Menu, Refresh.

click-drag Clicking once over an item and moving the mouse tells SWD to 
perform some action. Dragging & dropping files can move, copy or 
alias the selecter item(s).
Dragging an item or group of items from one directory to another on 
the same disk will move the items. To force items to be copied on 
the same disk, you can press the ctrl key while dragging the item(s).
Dragging the same item or group of items to another disk will copy 
the items. See also: ctrl-drag.

click-draw Clicking on the window background and dragging it across the 
window face will draw a box around the items within the box. When 
you release the mouse button, the group will be selected.
You can also press the shift key and add individual items to the list 
of currently selected items.

alt-drag Creates an alias of the selected file in the destination directory (or 
on the destination disk).

alt-double-click Pressing the alt key while double-clicking will bring up the Properties
dialog for an item.

ctrl-drag Copies an item or group of selected items from one directory to 
another.

right-click Brings up a context (sensitive) menu for the item (eg: file, directory). 
This Context Menu contains a number of related actions that can be 
performed on that item.

Dragging & Dropping
The term dragging refers to pressing & holding down the left mouse button and then moving the cursor 
to a new position. Dropping an item indicates you have let up on the button and may cause SWD to 
perform some action. The international "no" symbol is used to indicate where dropping the item will have
no effect.

Directory Windows



Move The default action if the item has been dragged to the same drive.
Copy ctrl-drop. The default action if the item has been dragged to a different drive. Make sure you 

hold the ctrl key until after releasing the button.
Alias alt-drop. Creates an alias in the destination directory which tells SWD how to find the real 

item. This can be useful for grouping files together for a specific project while maintaining 
your existing file organization. Make sure you hold the alt key until after releasing the button. 
The text associated with aliased items is displayed in italics.

Run Drop the file onto an application. Handy for general use, and especially when you need to run
a different application on the document. For example, drop a .DOC file onto WinWord, Write, 
NotePad, or your choice of word processors or text editors.

Trash Drop an item on the trashcan moves the item to the \TRASH directory on the current drive. 
The trash can then be emptied to physically delete the items. (To delete without the extra 
step, simply press the DELete key, and you will be asked to confirm delete of the current 
selection).

List Windows
Alias The default action for list windows.
Copy See description for Directory Windows above.
Run See description for Directory Windows above.



Icons
Since Windows is a graphical user interface (GUI), icons have been designed to present a picture you 
can use to quickly identify files, etc of the same type. With this in mind, the Silver Wolf Desktop uses a 
number of icons that will be familiar to you as well as several that should be fairly obvious what they 
represent. Below are some of the icons which SWD uses to identify various items. Other SWD icons 
may be found by examining the See Also list below.

The Silver Wolf Desktop (SWD) icon.

SW Desktop Configuration utility.

Batch programs have been around since MS-DOS was first introduced and, 
since these files end in .BAT, we thought this a most appropriate icon. SWD 
allows you to run these programs without having to create a .PIF (program 
information file) file.

See Also
Application Menu
Options Menu
Window Menu
Drives Menu
Help Menu
Command Icons
Context Menus
Windows & Their Contents



Command Icons
Command Icons are defined in the SWD.INI file and are related to the file associations set for a given 
DOS filename extension (ie: .TXT). The trashcan looks similar to the Command Icons but is handled in a
different way.
SWD is pre-configured to provide a drag & drop service to view, edit and print files through these 
Command Icons. You can define your own Command Icons to match actions in the Registration 
Database or just for your own needs (to allow files to be dragged onto an icon on the desktop). This 
process is described in the Advanced Topics section.
As you drag an item over various objects on the desktop, the icon will either become the international no
symbol or change into the icon representing the application that will run if you drop the item. Objects 
such as windows, disk drives, the trashcan, and Command Icons will also display a message to say if it 
will accept the item.

Context Menu
The built-in view, edit, and print functions, which use the pre-configured Command Icons of the same 
names use, are also available on the item Context Menu. This gives you a quick way to use one of these
functions using either the mouse (right-click on the item) or the keyboard (press spacebar).

Related Icons

Edit

The Windows 3.1 NotePad application provides the default text editing 
capability if no editor is defined for a filename extension.

View

SW Desktop text/hex viewer utility. This icon represents the default file 
viewer, provided with the SW Desktop, to be used if no file association exists 
for the file. If a file association does exist, the appropriate application is 
brought up to view the file in its native format.
When you press enter or double-click on a file and there is no file association 
for the filename extension, the SW Desktop will bring up the View Command 
Icon.
This utility is limited to three viewing modes: text only, hex only, and a 
combination view where the hex is shown to the left and printable ASCII 
characters are shown to the right. This modified hex mode replaces non-
printable characters with periods (.).

Print

If there is a print command association in the Registration Database, the 
associated application will be run to print the file. Otherwise, the SW Desktop 
print utility will attempt to print the information as best it can.

See Also
Icons
File Menu
Advanced Topics



The Trash
The trashcan, usually found in the lower right corner of the desktop, represents a place 
where you can place some directory or file until you are ready to remove it from your 
computers disk. You should realize that dropping an item or group of selected items into the
trashcan does not remove it from the disk. The item(s) are moved into the \TRASH directory
located on each disk.
Throwing something into the trashcan will not free up disk space.
Clicking on the trashcan icon will bring up a menu with the choices Empty Trash and Undelete options 
(among standard Windows 3.1 application choices). Selecting Empty Trash will remove any files or 
directories from the \TRASH directory. Items in the trashcan are now physically removed from the disk, 
freeing up the space required to store those items.
Selecting Undelete brings up the Microsoft Undelete application. This application can help you recover 
files that have been deleted from the disk though not every file is recoverable.

Related Icons
The normal trashcan indicates there is nothing in the trash.

A stuffed trashcan indicates you have thrown something into the trashcan.

See Also
Icons
Delete key



Cursors
Various cursors are displayed by SWD to let you know what you are doing. If you have used Windows 
for any amount of time, you have become accustomed to the normal and hourglass cursors. They let 
you know when you can do work and when the computer is doing something. SWD uses other cursors 
to give you visual clues as to what action you may be about to perform.

Normal cursor. When you see this cursor, you can select items and perform 
other actions.
The hourglass is recognized as indicating your computer is busy doing some 
kind of work that cannot be interrupted.
Copy an item or selected group of items (ie: files or directories) from one 
location to another. Dropping the item(s) when this cursor is being displayed 
will copy the item(s) from their previous location to this one.
If the ConfirmCopy option is set, you will be asked to confirm you want to 
copy the item(s) to the new location. If any items by the same name exist and
the ConfirmOverwrite option is set, you will also be asked to confirm each 
duplicate item replacement.
Items are copied by dragging an item or group of items from one disk to 
another, holding down the ctrl key while dragging item(s) from one directory 
to another, or selecting Copy from the Context Menu.
Move an item or selected group of items from one location to another. 
Dropping the item(s) when this cursor is being displayed will move the item(s)
from their previous location to this one. When the operation is done, the 
item(s) will not exist in the original location.
If the ConfirmMove option is set, you will be asked to verify you really want to 
move the item(s). If any items by the same name exist and the 
ConfirmOverwrite option is set, you will also be asked to confirm each 
duplicate item replacement.
Items are moved by dragging an item or group of items from one directory to 
another on the same disk or by selecting Move from the Context Menu.
The mini-document-stack icon indicates that some sort of action will occur to 
a group of files. Most likely the files associated applications will be run. If you 
drop a file onto some other object -- be it a Command Icon, Window, or other 
file -- the cursor will change to indicate if the object will accept the drop (eg: 
run Microsoft Word).
The international no symbol indicates nothing will happen if you drop the 
item(s) when this cursor is displayed.

See Also
Icons
Mouse



Menus

File Menu
Selection
Associate
Finding Files

Application Menu
Options Menu

Default View
Default Sort

Window Menu
Drives Menu
Help Menu
Context Menus



File Menu
The File Menu is separated into several sections: Desktop layout, file actions, wallpaper, item selection 
actions, and ways to bounce or end SWD and/or Windows 3.1.
The Desktop layout section allows you to save your current desktop layout (which folders are open, etc) 
as a specifically named file. Desktop layouts are saved in .DT files which reside in the same directory 
with the SWD.EXE application. A default layout, called DEFAULT.DT, is brought up automatically when 
SWD initiates. Used in conjunction with aliases, these layouts can be used to manage projects.
Open Desktop opens a previously saved layout. By saving different layouts you can 

quickly change the open windows on the desktop to suite your needs. In this way you 
can tailor the desktops look to each project you are working on.

Save Desktop saves this default configuration. This is the layout the SW Desktop will use 
when it first comes up. If no DEFAULT.DT file exists, no windows will be opened on the 
desktop.

Save Desktop As allows you to save a desktop layout as a name you choose. You can, of 
course, save the layout as DEFAULT which will replace the initial layout the SW Desktop 
will use upon startup. By doing so, you save the layout of the currently open windows.

Restore Desktop is simply a quick way to open the default desktop layout. With this 
command, you can quickly refresh the desktop to its starting layout.

Note: SWD does not remember what layout was opened most recently. Selecing Save 
Desktop will replace the default layout.

The file action section allows you to create a new folder (ie: disk directory), find similarly named or 
otherwise related files (& place links to them together in a list window), as well as create.
New Folder allows you to create a new directory on the disk within the currently open 

directory window. Thus if C:\WINDOWS is the active window, creating a new folder called 
UTIL will create a directory called C:\WINDOWS\UTIL.

Find builds a list window of related files. The Find dialog box allows you to specify a DOS 
file specification and, optionally indicate you only want Windows-capable programs or 
Windows group files.

Associate enables you to associate a DOS file suffix (ie: .TXT) to an application program 
(ie: MegaEdit.EXE). Associate allows you to specify a file suffix and then browse the disk 
to find the appropriate program. Once the association is established, double-clicking or 
pressing enter on files with the same suffix will run the associated application with that 
file.

The Change Wallpaper selection simply provides a quick way to change the Windows 
background display, called the wallpaper.

The Selection menu choice brings up a menu very like a Context Menu but which is fairly 
generic to work with most items on the Desktop.

The Desktop end menu choices are fairly obvious:
Exit Windows brings all of Windows down, terminating any active tasks in the process.
Restart Windows bounces, or restarts, Windows (handy if youve changed WIN.INI or 

SYSTEM.INI).



Reboot System will restart your entire computer.
Exit ends SWD without ending Windows itself. This last menu choice will not appear if the

SW Desktop is running as the Windows shell.

See Also
Icons



File Selection
The File | Selection menu (shown below) provides an action-oriented, or Context Menu, for file/directory 
items. This menu gives you the ability to copy, move, delete, view, edit, etc files and directories.



File Associations
The File | Associate command allows you to create or change the associations for a given filename 
extension. You can easily tell if an association exists for a file when using the Icon View as the icon for 
the file will either show the no-association icon (below) or the icon of the associated application. 
Selecting this command will bring up a dialog box that may look like:

In this example, we are about to associate all files ending in .LST to some application. Pressing the 
ESCape key will cancel this request while pressing the enter key will bring up a standard file browse 
dialog so you can search for the applications codefile. As soon as the association has been made all 
files ending in the specified filename extension will be shown with the selected applications icon.

Related Icons
Indicates there is no association from the file to any appliction.

Finding Files
The File | Find command searches the specified disk or directory (including all subdirectories) for a file 
specification. In the example below, we are asking SWD to search for all files matching *.ZIP. As the 
search progresses the current directory being searched will be shown in the Find windows status bar.

The result is a list window containing the files that satisfied the search criteria. Note that list windows are
read-only. This means that attempting to delete an entry from the Find window will only remove it from 
the current list window; the file will not be deleted from the disk. You can, however, press enter or 
double-click on items in the list to open/run them.
If you changed the Path to start from to C:\WINDOWS, SWD will only search this directory and any 
subdirectories. So, if you only wanted to find the Windows initialization files in your Windows directory 
(and any subdirectories) you would enter *.INI in the Filespec to find field and C:\WINDOWS in the Path 
to start from field.
Two check boxes allow you to limit the search to Windows EXE (set the search criteria to (*.EXE) files 



or Program Manager Group (set the search criteria to *.GRP) files. The first option allows you to find 
applications designed to be run under Windows 3.1 (as opposed to DOS programs). The second option 
allows you to move .GRP files to directories other than the Windows directory. Why would you want to 
do that? When Program Manager initializes it must rebuild each group file found in the Windows 
directory. If you have large group files or a lot of them this can slow the initialization process down. By 
moving rarely used group files to another directory (ie: :C:\WINDOWS\GRP) you can speed up Program 
Managers initialization and the SW Desktop still gives you access to these files (SWD opens PM group 
files as read-only list windows).



Application Menu
The Application Menu will present the top ten (10) items from the history list (icon plus file name) 
followed by several useful Windows-specific applications: DOS Shell, Program Manager, File Manager, 
Control Panel, Windows Setup, Clipboard viewer, Calculator, and Solitaire. These Windows-specific 
applications are provided in case you need them quickly.
The history list itself can contain more than 10 items but, for space reasons, only the ten most recently 
used files will be shown from the Applications Menu for quick reuse. The complete history list can be 
brought up from the Window | History List menu.
Note that you can use alt-D to quickly shell out to DOS without using any menus. You will be placed in 
the most recently active directory window.

Getting to the MS-DOS command line is easy: select this menu choice or 
press alt-D.
The Program Manager is the default interface for Windows provided by 
Microsoft. SWD combines the functionality of the Program Manager and File
Manager into one easy to use interface.
The File Manager is the default directory/file manipulation application 
provided by Microsoft. SWD combines the functionality of the Program 
Manager and File Manager into one easy to use interface.
The Control Panel application allows you to install drivers, modify the 
sounds Windows assigns to events, selecting the background wallpaper or 
the screen saver, etc.
Windows Setup has been provided on this menu as a quick way to change 
the configuration of Windows 3.1, install new print drivers, etc.
The Clipboard viewer displays the current contents of the Windows 3.1 
clipboard.
The Calculator, next to Solitaire and MineSweeper, is probably one of the 
most useful Windows 3.1 utility applications.
If you play Solitaire, you know why it is on the menu. Enough said.

See Also
Icons



Options Menu
The Options Menu lets you modify several options that control how the SW Desktop will present 
information to you. The SW Desktops configuration can be updated from the Options | Edit Preferences 
command, by explicitly running CONFIG.EXE, or manually editing the SWD.INI file.
Default View allows you to decide how SWD windows will be displayed.
Default Sort allows you to define the order in which the items are shown in a window.
Default Icon Spacing defines the amount of space Windows should place between icons. 

The default is 75 (horizontal) by 75 (vertical) and may be set for this session or saved to 
the WIN.INI file by checking Save settings to WIN.INI.

Note: Changing this option will also affect how Program Manager displays its icons. This 
is one of the few situations where the SW Desktop affects other Windows 3.1 
applications.

Test Font allows you to quickly preview how selecting a different font will look when 
displaying Directory and List windows. Any changes you make to the display will not be 
saved; permanent changes to the font used by SWD are made by the SWD Config 
module (use Options | Edit Preferences menu command). This command allows you to 
quickly see how a new font will look before making it permanent. The SW Desktop 
displays all text using a single font with the bold and italic attributes used to display 
directories and aliases, respectively.

Edit Preferences only appears if SWD finds the SW Desktop configuration utility. This 
utility provides all of the SW Desktops options 

Edit SWD.INI brings up the default text editor with the SWD.INI file. You can then manually
change SW Desktop options as needed. This selection has been provided to give those 
who prefer making changes to the .ini file. The preferred method of updating or changing
the SW Desktop configuration is to use Edit Preferences (above).

Making changes to this file requires the Desktop to be restarted.
Edit System files will bring up the System Editor to edit the files central to the 

configuration of your computer. This can be useful while installing new hardware or 
software that attempts to reconfigure your system.

Changes made to the Win.INI and System.INI files require Windows be restarted (File | 
Restart Windows) to take effect.

Changes made to the Config.SYS and AutoExec.BAT files require your entire system to be
restarted before those changes take effect.

Edit Associations allows you to update the file associations directly. This advanced 
feature allows you to change, add and delete file associations. Care should be taken 
before making any modifications to this information. Refer to your Windows 3.1 
documentation for more information about file associations and the Registration 
Database.

Related Icons
The System Edit application, provided by Microsoft, allows you to view and 
edit the four core files to configuring your computer and Windows: 
Config.SYS, AutoExec.BAT, Win.INI and System.INI.
Select Edit System files from the Options menu.
File associations are modified through the REGEDIT.EXE program provided 
with Windows. Select Edit Associations from the Options menu.



See Also
Icons



Default View
The Options | Default View menu changes the how the SW Desktop will open new directory and list 
windows. The current window will also be changed to the new view.

As Icons is the initial default when SWD is installed. Using this view you will see icons 
displayed for each file and directory with the items DOS filename underneath. If a long 
name has been defined for the item, then the long name will be displayed instead.

As Text simply displays the items DOS filename.
As Text & Info lists items by their DOS filename and displays the file type (eg: 

associated file, executable file, etc), size, date/time and long name.
As Buttons displays the association icon for an item as a button. Creating a button bar 

can be useful for unique lists of files such as the Registered Applications (Window | 
Registered Applications) where there are unique icons for each application.

You could also create a directory containing aliases of your most used applications and 
change its default view to As Buttons. This would give you a quick way to bring up 
these applications. To make this button bar appear on the desktop whenever the SW 
Desktop is brought up you could create an alias of this application directory in SWDs 
Startup directory.

Mask allows you to display only certain files based on a DOS file specification (eg: *.ZIP). 
Normally the Mask is set to *.* so all files in the directory will be displayed.

Hot-Keys
Alt-1 changes the current window to the Icon view.
Alt-2 changes the current window to the Text only view.
Alt-3 changes the current window to the Text & Info view.
Alt-4 changes the current window to the Button view.



Default Sort
The Options | Default Sort menu changes how items in directory and list windows are displayed. You can
sort the view by Name, by Filename, by Path, by Extension, by Date/Time, by Size, or none. This 
sort will be in ascending order unless you choose Reverse Order at the bottom of this menu.

Sorting the items by the Name refers to the long name the SW Desktop allows you to define. If there is 
no long name, the DOS filename is used. This choice may slow display of windows as SWD needs to 
examine any file associations as the window is being built.



Window Menu
The Window Menu lets you manipulate the various windows (ie: folders) on the Desktop. The first part 
of this menu lists the currently open folders, showing a directory or list folder icon followed by the name 
of the folder. Following this list are several choices which can help you work with these folders; they 
include:
Program Manager Groups which brings up a list folder containing the currently defined 

groups. These .GRP files are found in your Windows directory and, in many cases, are 
defined as you install new applications.

Registered Applications brings up a list window containing the entries found in Windows 
Registration Database. This Registration Database is the method by which Windows 
achieves application integration (including OLE).

History List brings up a list window containing the entire list of files and applications you 
have opened (run). The history list displayed on the Applications Menu only shows the 
ten (10) most recently used files. Removing items from this list is as easy as pressing the
delete key. Remember, deleting something from a list folder does not remove it from the 
disk; the item is simply removed from the list.

This history list is maintained in a file called DEFAULT.HST which can be found in the 
same directory where you installed SWD. If you remove this file, SWD will begin creating 
the history list from the next file or application you open.

Open brings up a dialog box for you to enter the name of a DOS directory you would like to
open. If the directory exists, it is opened and its contents are displayed in a directory 
folder (window).

You can enter the name of a file in this dialog box and SWD will open (run) the file. When 
a file is opened, it is added to the history list; directories are not included in the history 
list.

Close All closes all open list and directory folders effectively clearing the desktop. All that 
will remain are any running applications, the Disk Icons and the Command Icons.

Minimize All minimizes all currently open list and directory folders (windows). They will be 
arranged where there is room on the desktop.

Restore All reopens any minimized folders and places them on the desktop where and 
sized as they existed before being minimized.

Related Icons
Program Manager groups contain manually (or installation) defined 
references to selected files. These files are usually Windows executable files 
(.EXE, .PIF) but can also be files with associated programs.
The Registered Applications database is modified through the REGEDIT.EXE
program provided with Windows.
This icon represents a directory window or folder which, in turn, represents 
a physical DOS directory on a disk drive. Double-clicking on this icon will 
create a new window and open the directory.
A list windows or folder is a special read-only window containing references
to physical files. A list folder may be the result of a File | Find, requesting the 
history list or the Program Manager groups. Deleting items from a list folder 
merely removes the reference to the real file; the actual file is not touched by 
this action.

See Also
Icons
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Windows & Their Contents



Drives Menu
The Drives Menu presents the available disk drives followed by a number of related actions. The list of 
available drives are presented with an identifying icon and the name of the disk. These are the same 
icons and names that appear along the right edge of your screen. They are found on this menu to help 
those who prefer to use the keyboard over the mouse.

Identifies a 3½ floppy (removable) disk drive. When a disk is opened on this 
drive, SWD will determine its density -- either 720Kb or 1.44Mb -- and note it
on the drive icon.
Due to the nature of PC-compatible hardware, DOS and Windows 
applications cannot always know when you have removed a disk from a 
floppy drive. For this reason SWD may continue to display the label 
information for the last disk opened on the drive long after the disk has been 
removed. If you double-click on the drive icon, SWD will try to open the disk 
and fail (when no disk is in the drive). When this happens, SWD will display 
the default label. eg: A:1.4m (No Disk)    
Identifies a 5¼ floppy (removable) disk drive. When a disk is opened on this 
drive, SWD will determine its density -- either 360Kb or 1.2Mb -- and note it 
on the drive icon.
Identifies an internal, or possibly external, hard disk drive. Drives associated 
with this icon are not considered removable. The capacity of the disk and the
disk label will be displayed. For example, C:524m SYSTEM_DISK, indicates
the C: disk drive can hold 524Mb and is called SYSTEM_DISK.
Identifies a CD-ROM disk drive. SWD does not differentiate between internal
and external drives. Also, SWD does not include a music player so youll 
need to get an application to play music CDs.
Identifies a network drive. Network drives may or may not be available at 
any given time. That is why the Window Menu choices Browse Network, 
Connect Drive and Disconnect Drive have been provided.
Identifies a ram drive. This drive is not a physical device but, rather, an area 
of memory pre-allocated to look, appear and act like a disk drive. Using a 
ram drive can speed up access to reference information (eg: files included in
a compile).

When SWD initiates, it determines what resources are available and brings them up on the Drives Menu
and as Disk Icons on the right side of the screen. If a drive isnt available at this time (eg: you havent 
signed onto the network), you can add it later using the remaining commands on this menu:

Add to Desktop is used to add another drive to the desktops available resources.
Remove from Desktop is used to remove a drive from the desktops available resources. 

This can be useful for pseudo-drives (drive redirection or substitution), network, or other 
drives that may not be available all of the time.

Browse Network allows you the ability to select a remote or shared disk drive using a 
dialog box to select the appropriate network drive. This command can be useful when 
you need to look around (browse) for the disk you need.

Connect is used to connect to a shared directory on the network. From the window that is 
displayed you select can select the remote computer and disk drive to connect to your 
computer. When a new disk is connected, it is automatically added to the list of drives 
displayed on your desktop. This command is similar to the File Manager Disk | Connect 
menu command.

Disconnect removes the selected network disk drive from your systems list of shared 
drives.



See Also
Icons



Help Menu
The Help Menu gives you different opportunities to get help on various topics. SWD, like most Windows 
applications, uses online help files designed to use WinHelp.EXE provided with Windows 3.1 so you 
wont have to learn yet another help application. The commands on this menu include:
Contents brings up the main online help to the Contents page. This page provides an 

overview of the SW Desktop with links to other sections of the documentation.
Search allows you to search for the information on which you need help before bringing up

the entire online help document.
About simply identifies Silver Wolf Software as the author and owner of this software, 

displays the registered user, and indicates the version identifier.

Related Icons
Windows provides a standard online help interface which most Windows-
capable applications use. Many people, however, dont realize they dont 
have to run their application just to read the help. Double-clicking on a help 
file (.HLP) will bring up the online help for that application.

Context Menus
Context Menus, also called right-click menus, are activated when you press the right mouse button over 
an object on the desktop. A menu will popup which has been tailored for that object. For example, there 
are certain actions which only make sense for disk drives; therefore, disk drives have a menu tailored for
their specific needs.
Examples of Context Menus include:

Items -- files and directory folders. This menu can also be accessed from the File | Selection 
command.

List Windows. -- read-only lists (eg: History List, File | Find result, etc). Right click on the list windows
titlebar or the minimized list/folder icon.

Open Directory Windows. Right-click on the windows titlebar or the minimized folder icon. This menu
can also be brought up by pressing the alt key followed by the down-arrow key or clicking the 
system box at the upper left of the window. In both cases, you will need to select the Menu 
choice.

Disk Drives. Right-click on the drive icon that appears on the right side of the desktop.

Command Icons do not have a Context Menu as they are drop targets for files and directories which 
activate applications. The Trashcan does not have a Context Menu either; left-click on the Trashcan icon
to bring up the standard system menu for an application.



Projects & Aliases
Aliases and Desktop layouts can be combined to easily gather files related to a specific 
project without moving them around on your disk.
Essentially, an SW Desktop layout gives you the ability to save the currently open windows
to a named file. Layout files end in the DOS suffix .DT (for DeskTop) and are usually stored 
in the directory where the Silver Wolf Desktop has been installed. As a layout is opened, 
either the default layout (DEFAULT.DT) or a named layout (File | Open Desktop), each 
window that was open when the layout was last saved will be opened.
By defining aliases in different directories you can place the icon for a commonly used application right 
at your fingertips. When developing Windows applications, for example, Borlands Resource Workshop 
application can be extremely useful. For instance, you might keep each application in a separate 
subdirectory and    create an alias for the Resource Workshop in each of those directories so you dont 
have to go searching for this one application or keep yet another window open on the desktop. Aliases 
go a long way toward reducing desktop clutter.

By combining these two features you can easily build and manage temporary relationships between 
applications, files, and directories during the life of a project. To build a project:

1. Create a directory (or subdirectory) using File | New.
2. Create aliases for the various files and/or directories where project-specific information may exist.

An alias is created by pressing the alt key while dragging the file or directory into the project 
directory (created in #1). An alias may also be created using the keyboard alone. The text shown 
underneath the alias entry is italicized to separate it from real files and directories on the disk. 
Also, aliases can be from different disks.



Windows & Their Contents
SWD windows have a title bar, status bar, and can be moved and resized. The title bar contains the 
window type, followed by a colon (:) and the name of the windows contents. For example: Directory: C:\
WINDOWS
SWD windows contain items, usually shown as icons with descriptive text underneath. This text can be 
the files DOS filename (eg: SWD.EXE) and may include a long name. These items are arranged in a 
grid, which is automatically resized and scrolled as needed when the window itself is resized.
A default size and shape is chosen for the window when it is first opened, attempting to fit all of the items
into the window without scrolling and in a pleasing configuration. If the window is subsequently resized, 
the new size will be remembered whenever the window is opened in the future. You can also tell SWD to
refresh and/or resize any window from the windows Context Menu.
There are two basic types of windows: directory and list. A directory window represents an actual DOS 
directory while a list window represents references to items that may exist across several directories. 
Two examples of list windows include the history list and the File | Find results. List windows are read-
only; this means that pressing the delete key will not remove the item from the disk, simply from the list. 
It also means you cannot drag a file or directory into a list window.

Related Icons
This icon represents a directory folder    and a directory window. As a folder, 
the icon represents a directory on a disk. Double-clicking on this icon will 
create a new window and open the directory. When open, a directory folder 
becomes a directory window and, with this change the Context Menu also 
changes (you can do different things to a directory once it is open).
A list window is a window containing references to physical files. A list 
window may be the result of a File | Find, requesting the history list or the 
Program Manager groups. Deleting items from a list window merely removes
the reference to the real file; the actual file is not touched by this action.
The root directory of any disk is the top-most folder for that disk. If you type 
ctrl-<letter> the root directory for that disk (specified by <letter>) will be 
opened. So, for example, if you enter ctrl-E SWD will attempt to open the E: 
disk drive.
Indicates the parent disk directory for the current folder. The root directory of 
any disk does not have a parent directory. Selecting this icon, by double-
clicking or pressing enter, will open the current directorys parent (like the 
CD.. command in DOS).
Represents the directory where Windows has been installed. In this directory
you will find a number of default applications such as the Program Manager 
and File Manager (among others) as well as initialization files (.INI) for many
applications.
Represents Windows system directory. This directory usually contains the 
installed fonts, dynamic link libraries (.DLL), controls needed by application 
(.VBX), etc.
Indicates the file is really a PKZIP v2.04g compatible archive file. The SW 
Desktop opens zip files as list windows so you can drag & drop files within 
the archive to other directories (SWD automatically extracts the selected 
files). You can also view or execute files in the archive without explicitly 
extracting them.
Since list windows are read-only, you cannot drag files into the zip window to
add to the archive.

See Also
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Tricks and Tips

Program Manager Groups
The SW Desktop treats Program Manager groups like any other list window. Therefore, opening these 
files by pressing enter or double-clicking on the item will display the programs and files defined in the 
group. In some cases, SWD can open these groups even if Program Manager reports them to be 
corrupted.

Speeding Up Windows 3.1 Startup
Since the SW Desktop can open Program Manager groups, you could move most, if not all, of 
these .GRP files out of the Windows directory. Windows will come up faster because it does not need to 
rebuild these groups. Obviously, the more groups you have defined, the more affect this action will have 
on Windows initialization.

Note: You probably want to keep a copy of MAIN.GRP (Main) and ACCESSOR.GRP (Accessories) in 
the Windows directory to provide the basic functionality to Program Manager.

Using Aliases
Aliases provide a way for you to several references to a single file or directory on your computers disks 
(the same or another disk) and treat it as the real file. This means, if you double-click on an alias of 
AMIPRO.EXE you will run (open) the real AmiPro word processor application. If you open the alias of a 
directory, you will open the actual directory window.
You can create a work directory that is brought up with the default layout containing aliases of your most 
commonly used applications: AmiPro, Word, Excel, Quicken, CompuServe Navigator, Address Book, Its 
Legal, EZ-Tape, dBase, etc. You could also create aliases of important files, such as: XMAS.CRD, \
PERSONAL, Music.DBF, Clients.MDB, etc.

Selecting Multiple Items
Pressing the shift key while using the arrow keys to move from item to item in a window will select each 
item. In this way you can select a number of files and/or directories into a group for action. What action? 
Copy, move, delete, alias, etc. Selected items are shown with a highlighted background around the text 
and/or icon.

Getting Out to DOS
There are three quick ways out to the DOS command line from the SW Desktop: 1) the Applications | 
DOS Shell menu choice; 2) from the current windows Context Menu, and 3) by pressing alt-D. Each of 
these methods open a DOS command-line session at the most recently active directory. That is, the 
directory which corresponds to the most recently open directory window.
Pressing ctrl-D will, however, take you out to the D: disk drives root directory (D:\). The root directory of 
any valid disk drive on your computer can be gotten to quickly by pressing the ctrl (control) key and the 
drive letter.

Finding Files
The File | Find command lets you search for like-named files quickly and creates a list window of the 
results. But, it can also search for Windows 3.1 applications and Program Manager groups which may 
be spread across the disk. Searching for all Windows 3.1 applications can take some time but, when 
done, you have a complete list of all Windows-capable programs on your computers disk.
Also, by changing the Path to start from you can search beginning with subdirectories. You can, for 
example, change the starting directory to C:\WINDOWS to search in the Windows directory and 
subdirectories. Or you could change it to E:\DATA to look through your CD-ROMs DATA directories.

Find Word Processing Files
To find all of your word processing files on a disk, you can use the File | Find command; give it *.DOC, 



*.SAM, *.WP*, etc for the search parameter and the result will be a list window containing all of your 
documents and letters. This makes searching for a particular document much easier.

Dragging Files To/From File Manager
The Silver Wolf Desktop is a fully drag/drop capable application. That means you can drag files to or 
from the File Manager and drop them on any SW Desktop icon including the trashcan, disk drives, open 
or minimized folder windows, or Command Icons.
Dragging files from the SW Desktop to an open group in Program Manager will automatically add that 
file to the group. Note that the group must be opened in Program Manager.

Displaying Icons
SW Desktop displays .ICO files using the icon stored within the file. This takes the guess-work out of 
determining what COPY.ICO represents; in our case, it is:

Type In Name to Run Program or Launch File
To run an application or open a file you can simply use the Window | Open command. Type in the full 
name of the file. For example, typing in the name

c:\windows\pbrush.exe

will open a window with this application.



Advanced Topics

Replace the Trashcan
You can replace the trashcan with your own trash utility by adding Trash to the Command Icons section, 
specifying the name and location of your trashcan program. You can make this change by editing the 
SWD.INI file directly (making the changes in the [Command Icons] section) or through the Options | Edit 
Preferences command.

Creating a Button Bar
One of the Options | Default View choices is as Buttons. But, it may not be obvious how this way of 
viewing a directory can be useful. You could create a directory and create aliases of the applications on 
your computer you use most often. Once this is done, change the view to as Buttons for this window by
pressing alt-F4. Now shape the window into a bar and place it in a convenient place on the desktop. You
now have a quick reference button bar.
But, how can you ensure this button bar comes up every time the SW Desktop does? Simply by creating
an alias of this directory in the SWD STARTUP subdirectory.

Editing File Associations
The SW Desktop, like the File Manager, allows you to easily and quickly associate a DOS filename 
extension (eg: .doc or .txt) to an application (eg: winword.exe or notepad.exe). In SWD this command is 
found on the File menu and file/directory Context menu.
The SW Desktop, however, also gives you full access to the standard Windows 3.1 editor, called 
REGEDIT, to update this information. If youve used the Registration Database Editor you know it is not 
for novice users.
So why does the SW Desktop provide easy access to this information? Simple: it is through REGEDIT 
that you can create your own Command Icons.
Two of the standard Command Icons, Edit and Print, tap into many existing relationships for various 
applications. Whenever you see the a REGEDIT definitions with these keywords in the name (ie: .pif\
shell\print\command = pbrush.exe /p %1) you know that dropping a file ending in .pif on the Print icon at 
the bottom of the desktop will print the file using its native application.

Establishing New Command Icons
The SW Desktop, as mentioned above, defines several default Command Icons including: Edit, View, 
and Print. You can, however, define your own Command Icons by defining commands in the 
Registration Database that match the name of the new Command Icon.
To add a new Command Icon you first need to have a default application which will attempt to handle the
request if no other application or process exists for different files. This default application may be the 
only application to perform the action (that is, no other app exists to do this action). You define a 
Command Icon called Email, for example, to the SW Desktop using the SW Config facility (or by 
manually adding it to SWD.INI) with the name of a default application:

[Command Icons]
View=VIEW.EXE
Print=PRINT.EXE
...
Email=MAILER.EXE

This might be all that is necessary to establishing the new Command Icon. What if, for example, different
applications provided a native file processing into your electronic mail server? In this case, you would 
either be tapping into a facility (and using their name for the Command Icon) installed by the applications
or defining the command after the fact. What does that mean?
Just as with the Print command, software developers use this common name to let their application print
their files automatically. The program uses a command line switch (ie: /p) to tell the application the user 
wants to print the file instead of the default action (usually Open). Developers could include another 



command line switch to provide translation of their file format into a standard to inclusion in electronic 
mail or some other service. If they did that, it would make sense that their setup program would install 
that command in the Registration Database automatically. If this is the case, you would only need to 
establish the Command Icon in the SW Desktop to tap into the Registration Database command.
If the developer does not install the command, you can do so by adding a new keyword to the 
appropriate applications and file associations for the keyword. For example, if the ABC application 
provided an email service through the command line, you could add the command below to the 
Registration Database:

HKEYS_CLASSES_ROOT\.abc\shell\email\command = ABC.EXE /mail %1

For More Information
If you need assistance adding Command Icons, contact Silver Wolf.



Registration Editor
The Registration Editor, called REGEDIT.EXE, is provided with Windows 3.1 for applications 
to install file associations automatically during the installation or setup process. It also 
allows users to view and update the detailed information which includes file associations as
well as DDE and OLE protocols.
REGEDIT can be run in one of two ways: standard and advanced. The SW Desktops Options | Edit 
Associations command brings up REGEDIT in the advanced mode as it provides a more detailed look at
the information in this database.
If you drop a Registration script file onto REGEDIT or run this program with the name of a file on the 
command line, REGEDIT will attempt to read the file and process commands within it. A .REG file begins
with the word REGEDIT on the first line followed by lines beginning with HKEY_CLASSES_ROOT. 
Anything else, at this time, is considered comments.
The HKEY_CLASSES_ROOT keyword, however, defines the command, or action, to perform by name 
and the application to perform. For example,

HKEY_CLASSES_ROOT\.pif\shell\open\command = pifedit.exe %1

indicates the file extension .PIF should be associated with the application PIFEDIT.EXE whenever the 
file is opened. In this case opened means you double-click or press the enter key on the icon for a file 
ending in .PIF. The %1 is replaced by the name of the associated file being opened. So when you 
double-click on a file called DOSCMD.PIF Windows 3.1, using the Registration Database entry above, 
actually runs the command:

PIFEDIT.EXE    DOSCMD.PIF

Note
Editing file associations should only be done under the direction of a vendors technical support 
department or by advanced users who understand the internals of the Registration Database and how 
changing this information can affect their Windows 3.1 environment.
Silver Wolf Software cannot accept responsibility if you decide to modify the Registration Database; this 
product can be used without any manual changes to this information. This capability is being provided 
for power users who want to extend the capabilities of the SW Desktop.
Before making any changes to this information, make a backup copy of the REG.DAT file found in your 
Windows directory. This will provide a way to back out of any changes if you find they do not work as 
you intended.

Registration Database
The Registration Database, called REG.DAT, stores several system-wide relationships including DDE 
and OLE parameters. The most commonly used information in this database is the file association. 
When you look at the Registration Database, you will see entries that provide direct associations (ie: .pif\
shell\open\command = pifedit.exe %1) or indirect association such as:

.pcx = pbrush

.bmp = pbrush

pbrush = PaintBrush Picture
shell\open\command = pbrush.exe %1
shell\print\command = pbrush.exe /p %1

In the above example, an association type is defined called pbrush. The commands open and print are
defined for this type. The file extensions .pcx and .bmp are associated with the pbrush type. Using this 
indirect method of file association you can associate several file extensions to the same set of 
commands.

Command Icons
The print and open commands are considered standard but you can create your own such as edit, 



view, etc. This is how the Command Icons work. The command is established in the SW Desktops 
initialization file (SWD.INI) and, if also needed for various applications, defined in the Registration 
Database. When you drop a file onto a Command Icon, SWD looks to see if there is a command 
associated with that file extension. If so, the command is executed; otherwise, the default application 
defined in the SW Desktops initialization file is used.



Macintosh Users
This section describes the similarities and differences between the SW Desktop and the Macintosh.

Terms

Files & Documents
By convention, the Macintosh uses the term "document" to describe an item in a window which may or 
may not have an application associated with it. In Windows 3.1, these documents are normally referred 
to as "files". The SW Desktop makes this transition easier by displaying files with no application 
associated with them as "document" icons, looking similar to a Macintosh "document" with no associated
application.

Folders & Directories
Macintosh users call them folders while the PC and Windows 3.1 community call them directories. In 
any case, these folders contain other documents (files) and folders (directories). Within the SW Desktop,
these terms are used interchangeably.

Aliases
SWD implements aliases, in the same fashion as the Macintosh. Aliases are created by holding down 
the alt key while dragging and dropping a file.

Note: Aliases are a quick, easy way to accomplish many things, and are simply a pointer to the file. 
However, if the original file is moved or deleted, the alias must be recreated or deleted as well. 

List Windows and Directory Windows
Directory Windows on the SW Desktop are the closest thing to those found on the Macintosh. These 
contain icons and are simply a reflection of the contents of the directory (folder).
List Windows are windows which contain read-only lists or collections of file items. You cannot delete 
items found in list windows; pressing the del key may simply detach the reference to the document (file) 
from the list but the document will not be removed from the disk. You can, however, copy, move, alias, or
drag/drop to run or open entries document (file) in the list. Double-clicking on an item in the list will also 
run or open the document (file). List windows include File | Find results, Program Manager groups, the 
History List, Registered Applications, etc.

Double-click
Double-clicking on a document (file) or folder (directory) will open the selected item. Just as you would 
expect, opening a folder will display the contents of that folder; opening a document will be opened with 
its associated application or, if none, the default Command Icon viewer.

Double-click to Close
Clicking on the upper left corner of a Windows 3.1 application drops-down a system menu. One of the 
choices on this menu includes Close which will request the application terminate. Double-clicking on the 
system box will also terminate the application. The keyboard equivalent is alt-F4.
This contrasts with the Macintosh where the upper-left corner of the application contains a simple close 
box.

Drag-select
You can select multiple items -- documents and/or folders -- in a window by clicking between them and 
dragging until a rectangle encloses the desired items. Windows 3.1 does not offer this capability 
anywhere -- in either File Manager or Program Manager. This action may also be called click-draw in the
SW Desktop.

Drag-drop
Like the Macintosh, if you click and drag an item (document or folder) from one window to another, or 



onto another object, an action may occur. While dragging an item on the SW Desktop, the cursor will 
change based on whether the object under the cursor can accept the item or not. If not, the cursor will 
become the international no symbol; otherwise, the cursor will reflect the application or action that will 
occur.

Moving & Sizing Windows
On the Macintosh, the small box at the lower-right corner allows you to drag the corner of the window to 
a new size. Under Windows 3.1, however, you must grasp the corner of the window frame.
You can see when the mouse is positioned to resize the window because the cursor changes to a 
diagonal double-arrow    ( . You may also size just vertically or just horizontally by grabbing the frame 
along the sides (not at the corner). In this case the cursor changes to a horizontal or veritcal double-
arrow (

 and 
).

Both the Macintosh and Windows 3.1 move windows by cicking on the title bar and dragging the whole 
window to its new position.
In addition, Windows windows may be moved and sized with the Move and Size choices found on the 
system menu (dropped down from the box located at the upper right corner of every window). After 
choosing one of these options, use the arrow keys to move the window or change its shape and press 
enter when you are done.
The first arrow key pressed determines the direction in which the wdo is moved or sized, and the Enter 
key terminates the move or size operation. The curson changes to a 4-way arrow during the operation:

Scrolling windows
Scroll bars along the right and bottom edges work in a similar fashion to the Macintosh. However, on the
Macintosh, the scroll bars are always present in the window frame; Windows applications, however, may
add or subtract them as needed.

Alt & Ctrl Keys versus Option and "Apple-Menu" Keys
The Macintosh has no alt key, but in it's place has both Option and Apple-Menu keys. Many of the same 
things the Option and Apple-Menu keys are used for also apply to the alt, ctrl, shift, or various 
combinations of these keys (possibly with other keys).

Keyboard Shortcuts Reference
option-. ctrl-C (DOS) or ctrl-alt-del under Windows 3.1 will abort the application.
reboot ctrl-alt-del twice under Windows 3.1
option v ctrl-v or shift-ins will paste the contents of the Windows clipboard into the location where 

the cursor has been placed.
option c ctrl-x of ctrl-del will cut the selected text, graphic, object or window area from the 

document and place it into the Windows clipboard. Cutting 

The PC Mouse
The mouse, trackball, or other pointing device on the PC usually has two or three buttons as compared 
to the Macintoshs one. Each of these buttons can be assigned various meanings. In Windows 3.1 
applications the left mouse button and the Macintoshs button are essentially the same. They are used to
select and issue commands by clicking and double-clicking on various objects.

The Right Button
Though it is not quite a standard yet, many Windows 3.1 applications are using the right mouse button to
bring up an object-oriented, or object-specific, menu. On the SW Desktop, for example, right-clicking on 



a disk drive icon will bring up a context sensitive menu with actions that only apply to a disk: Open, 
Close/Eject, Format, Label. The Properties dialog is usually the first entry in this menu.

That Middle Button...
The middle mouse button is not standard on the PC. In fact, there are many mouse-like devices that do 
not have this third button. It is usually used by CAD (Computer Aided Design) software. The SW 
Desktop does not make use of the middle button, if present, so you can ignore it.

Displaying Windows
The SW Desktop allows you to change how each open window displayed. The default view 
can be changed using the Options | Default View command.

Icon View
By default, Directory (folder) Windows display documents (files) and folders (directories) like the 
Macintosh with an icon with text underneath. Folders are shown as closed manila folders. Documents 
are shown with the icon representing their associated application, if any. Documents with no association 
will be displayed as a document page and files containing an icon will display that icon.

Text View
The Text View simply displays the filename (document name) only.    This view is very useful for quick 
browsing through documents as well as for very large folders (SWD doesnt need to investigate file 
associations for icons, etc).

Text & Info View
This is an extension of the Text View but, besides the filename, also includes the date and time the file 
was last modified, its size (in bytes), and type. Types include: Directory, Associated File, File Item, 
Runnable File, Executable File, Windows Exe File, Zip File, Alias for ...
This information can be obtained in any view by typing alt-enter or right-click to bring up the Properties 
window.



Technical Support
Silver Wolf Software provides technical support free to registered users of our software products through
CompuServe and the internet. More comprehensive support plans are available for a fee. We have site 
licensing plans available as well.

CompuServe: 71441,1637
internet: 71441.1637@compuserve.com

Registered users receive notice of upgrades and can submit feature suggestions which may be included
in future releases of the software. We dont promise to implement every suggestion but we will give each 
idea full consideration.
Support is also provided during the trial evaluation period (as defined in the README.TXT file).
Direct any written correspondence to:

Silver Wolf Software
PO Box 4232
Laguna Beach, CA 92652
Attn: SWD Support

Legal Stuff
This software, called the Silver Wolf Desktop, and its related documentation (both electronic and paper) 
are the property of Silver Wolf, Inc dba Silver Wolf Software of Laguna Beach, California USA. Use of 
this software past the evaluation period defined in the README.TXT file constitutes acceptance of the 
license and requires payment of the fees associated with this product.
This product is protected by US copyright laws. You may copy this software so long as all files released 
by Silver Wolf Software are included and no fee is charged except to recover duplication and/or 
distribution costs.

Copyright © 1991-1994 Silver Wolf, Inc dba Silver Wolf Software
All Rights Reserved.



SWD Registration Form
Print this form, fill it out and mail or fax it to Silver Wolf at:

Silver Wolf Software

PO Box 4232
Laguna Beach, CA 92652
Attn: SWD Support

Name: ___________________________________________
(please print your full name)

Company: ___________________________________________

Address: ___________________________________________

___________________________________________

___________________________________________

Telephone: ___________________________________________
(include country code plus city/area code)

Disk Media: [      ] 3½ [      ] 5¼ (check one)

Payment
Method:

[      ] Check [      ] Money Order
[      ] MasterCard [      ] VISA

Credit Card Orders

Card #: ___________________________________________

Expiration: ____/____

Signature: ___________________________________________
(as it appears on the card)

______ Copies @ $39.00 US each: $ ________

CA Sales Tax (if applicable) $ ________    (usually 8.25%)

Shipping & Handling $    3.00

Total $ ________

Glossary
Alias



Associate
Click, Mouse, Button
Command Icons
Context Menu
Cursors
Directory Window
Folders
History List
Hot-keys
Icons
Items
List Window
Long Name
Properties
Refresh window
Registration Database
Resize window
Selecting Items
System Menu
Trashcan
Windows



Aliases and .ALS Files
An alias provides a way to have several references to a single file within different 
directories on your computer. These aliases are very much like aliases on the Macintosh 
and shortcuts within Windows 95. The SW Desktop creates an alias by creating a file with 
the .ALS extension; contained within this file is the name of the actual file. Even though this
small file is not itself a word processing document, spreadsheet, etc it directs the SW 
Desktop to find the original file and perform actions such as launch or run on the original.
So, for example, you could keep your spreadsheets and documents in different directories 
on the disk but create an alias in one or the other directory (or even a third directory) for 
each file related to a specific project or client. These aliases are easy to create and remove 
without compromising your file organization.
Running the alias file is the same as running the actual file. If you copy or move the alias 
file, however, you are manipulating the alias file (.ALS), not the actual file. Deleting the 
alias file does not delete the original file. Alias files are shown with the same icon as the 
original file but their default long name identifies it as an allias. You can, of course, change 
the long name for the alias.

Alias for
VDISPLAY.EXE:

Set Laptop Display Mode



Associations
Windows allows you to associate a DOS filenames suffix part, or extension, with an 
application so that when the file is opened the application is run with the file as input (a file
is opened by pressing the enter key or double-clicking on the files icon). SWD provides easy
access to this powerful capability through the File | Associate and Options | Edit 
Associations.
The File | Associate command lets you create or change the application associated with the 
filename extension. Options | Edit Associations brings up the Registration Info Editor, 
allowing you to make detailed modifications to these associations.



Click, Mouse, Button
Mouse actions -- pressing the left or right buttons, dragging the item, etc -- tells SWD to perform some 
action on the selected file, directory folder, or window.
Clicking the mouse button(s) simply means pressing one of the buttons on the mouse or trackball 
pointing device. Unless otherwise specified, click indicates pressing the left mouse button. Click-Drag 
indicates you should press the left button and hold it while moving the mouse. Click-draw refers to 
clicking in the windows background and drawing a box around a number of items; these items are then 
selected. Double-clicking indicates you should press the left button twice in quick succession.
Pressing the shift key while clicking on an item will add it to the group of selected items. In this way you 
can select a number of files and/or directories to be copied, moved, etc. Pressing the ctrl (control) key 
while click-dragging an item will ensure it is copied from one location to the other. Pressing the alt key 
while click-dragging an item creates an alias of that item -- file or directory -- in the destination directory.
Clicking between items in the window refreshes the display; SWD re-examines the directory to see if any
files have been added or removed.
Right-click indicates you should press the right mouse button. This brings up a context sensitive menu.



Command Icons
Command Icons are dynamically created commands you can place on the desktop, as icons. The viewer
and editor are examples of pre-defined command icons. You can create your own based on the 
Registration Database (see the Advanced Topics section). Default Command Icons include:

SW Viewer (text/hex file viewer)

NotePad (simple editor)

SW Print



Context Menu
Context Menus pop-up when you press spacebar key or the right mouse button over some kind of object
on the desktop. These menus are called context menus because they change depending on the object 
you have selected. Therefore, the Context Menu for a disk drive is different for a file or window. Context 
Menus may also be called object menus or object-oriented menus since they change based on the 
object being affected.
The SW Desktop supports Context Menus for: list windoww, directory windows, disk drive icons, 
file/directory items.



Cursors
Cursors can change based on what you are trying to do. Normally, the cursor is the 
standard Windows arrow but this can change when you drag files or directories, etc. 
Several standard cursors include:

Copy item(s)

Move item(s)

Cant drop here



Directory Window

A directory window contains the contents of a DOS disk directory -- files and subdirectories. Opening the 
directory C:\WINDOWS, then, will create a directory window containing the files installed with Windows 
3.1 and at least one directory window called SYSTEM.



Folders

Essentially folders are closed directories. This is why directory windows, when closed or minimized, 
appear as a closed folder. When you press the enter key or double-click on a folder icon, the folder is 
opened as a directory window. By opening a folder you can see what files and other folders are to be 
found within.



History List

The history list contains the last n programs or files that have been run or opened. The list can be 
accessed in two ways: 1) through the Applications Menu and 2) through the Window | History List.
The Application menu provides a quick list of the ten (10) most recently used files or applications while the
Window | History List command brings up a list window containing the entire history list.
The history list is maintained in the DEFAULT.HST file found wherever SWD was installed. If you remove 
this file, the history list is cleared. You can also clear the history list by opening the history list window 
(choose Window | History List) and pressing the delete key on each item. This does not removed the file 
from the disk, it simply removes the entry from the history list. Once the history list is empty, its window 
goes away.



Hot-Keys
Hot-keys are keyboard you can use to perform an action or perform an operation on a file 
or directory. An example of a hot-key is alt-D which gets you access to DOS. In Windows 3.1
these hot-keys are activated by pressing the alt key while pressing the underlined letter of 
the menu or field name.
The ctrl key also provides several unique hot-keys which are usually shown on various menus.



Icons
Icons are little pictures that give us a visual clue to the different types of items found on 
your computer. Most of these icons are associated with an application/program you have 
purchased and installed. When you double-click on an icon, SWD opens that file or 
directory. Dragging the icon to another directory window (item is copied or moved), onto a 
Command Icon (action -- edit, view, etc -- occurs) or Disk Drive icon (item is copied to the 
other disk), or onto the desktops background will cause some action to occur (file is 
launched/run, directory is opened). Below are a few examples of icons:



Items
An item consists of an icon, its associated text (name), and properties (attributes). An item 
can be displayed in more than one way based on the Options | Default View setting. When 
an item is selected in a list or directory window, some of its related attributes may be 
displayed in the status bar at the bottom of the window.
Items can be files, directories, or lists of files. Each item on the SW Desktop has different 
attributes and, therefore, respond differently to the same action. For example, when you 
open a directory or list window is opened to show the contents of the item; opening a file, 
however, may cause a program to be run to allow you to view and/or modify the contents 
of the file.
A Context Menu, which can be accessed by pressing the spacebar or the right mouse button, provides 
quick access to commands you might want to use with each item in the window. An items properties can
be viewed and updated by pressing alt-enter, double-clicking on the text under the icon, or from the 
Context Menu.



List Window

List Windows contain lists of items and are created from the File | Find command, the history list, Program
Manager group list, etc. The items contained in the list are not physical files but, rather, references to the 
real file (like an alias). Therefore, list windows are read-only; meaning a number of actions are not valid 
for list windows (ie: file or directory cannot be dropped onto a list window). Deleting an entry from a list 
window simply removes the entry from the list; the file it represents is not affected.



Long Name
The SW Desktop supports long filenames just like the Macintosh, Windows NT, and 
Windows 95. A long name allows you to give your files more meaningful names by allowing 
up to 128 characters, including spaces, in the name. So, EX941230.XLS can    become 1994 
Expense Summary.
If you copy or move items between disks, including floppies, the long name is copied as well.
Since aliases are stored in .ALS files, aliases can also have unique long names.



Properties
Each object on the SW Desktop is composed of behavior and properties. These properties are found 
using the various Properties menus. A property menu exists for Items, Directory windows, List windows, 
and Disk Drives. Since each of these objects is different, each has different properties.
For example, an open directory window has the following properties: type (directory window), items 
(number of items in the directory), size (in bytes), long name, path, display mask, sort criteria for items in
the window, position of the window, and how to display the items (as icons, text only, etc). Some of these
properties can be changed by you and some cannot.



Refresh Window
The Refresh command, found on a windows Context Menu, re-reads the disk directory to update the 
display. This command can be very useful when the window is a directory on the network where other 
people may be updating the disk. It can also be useful if you go out to DOS to perform file management 
or an application creates/updates/removes files.



Registration Database

The registration database is a facility provided by Windows 3.1 to implement better integration between 
applications. The registered applications list and file associations are affected by this database.



Resize Window
The Resize command, found on a windows Context Menu, re-examines the items in the window and 
determines the best window shape. Windows can be manually resized by grabbing the borders of the 
window witht the cursor, pressing the left mouse button and dragging the border to reshape the window.



Selecting Items
You can select a group of items for some action (ie: copy, move, delete) in several ways. Click on the 
window background and drag the mouse; this is called click-draw. As you drag the mouse a box with a 
dotted border will appear and, when you release the mouse button, all file or directory items inside the 
box will be selected. Selected items are shown with a different color background defined by Windows 
Colors (see the Control Panel application to change Windows colors, if you are interested).
Continuing with the mouse, you can press the shift key while clicking on individual items in the window. 
This will toggle the selection of that item. That is, if the item was selected, it will be de-selected; if it was 
not selected, it will be added to the list of selected items.
Using the keyboard, you can press shift-spacebar to toggle the selection of an item. Also, pressing shift 
and any of the arrow keya will move in the direction of the arrow and select the next item.
You can only select a group of items in the same window.



SWD

The abbreviated name for the Silver Wolf Desktop.



System Menu

The system menu is a standard part of every Windows 3.1 window or application. This menu drops down 
from the little box at the upper-left corner of the window when you click on the box or press the alt key. 
The SW Desktop places a directory Context Menu (choose Menu) on the system menu. From this menu 
you can quickly resize, refresh, associate, copy, update the windows or the selected file/directory 
properties, etc.



Trashcan

The trashcan icon represents a place where you can place things you want to throw away without 
actually losing the information. Dragging an item -- file or directory -- to the trashcan places it in the \
TRASH directory of the disk but does not remove the item from the disk itself. It is a good way to remove
the item from your sight but keep it around in case it is still needed. You can pull things out of the trash 
so long as you have not emptied it (a trashcan menu choice). Once the trashcan has been emptied the 
item is removed from the disk.
Directories moved to the trashcan are also moved to the \TRASH directory as well.
Pressing the DEL key immediately removes any files or directories from the disk



Windows
The term window is one of those things that means different things depending upon the circumstances. 
Within the SW Desktop, however, a desktop window is any open directory or list opened and displayed 
by SWD. A directory displays the closed folder icon until is it opened. When the directory is opened, its 
contents are displayed in a window.
In general, the term also refers to the display area assigned to individual applications as well.



Quick Reference

Files & Directories
Key Mouse Description
enter double-click Open/run the file or directory.
spacebar right-click Bring up the Context Menu for the object.
del right-click, Delete Delete the item from the disk.
esc double-click 

system box
Close the currently open window.

backspace Open parent directory in same window.
home, end Goto first or last item in the window.
pgup, pgdn click window 

scrollbar
Jump through several items in the window.

click window 
background

Display the number of items in the window, the disk space 
(in kilobytes), and the amount of available disk space in 
the status area of that window.

arrow keys click Select an item in the window. This will de-select any other 
item(s) that may have been selected.

shift-arrow Add next or previous item to group of selected items. See 
click-draw.

shift-spacebar shift-click Toggle the selection of an item. See shift-arrow and click-
draw.

<letter> Goto next item in the window beginning with <letter>.
alt-enter right-click, 

Properties
Bring up the Properties for the file, directory, disk drive or 
window.

alt-1 Display current window with icons and the filename or long
name underneath.

alt-2 Display current window with filename only.
alt-3 Display current window with filename, date/time, size, etc.
alt-4 Display current window contents as buttons (no text).
alt-D Goto DOS.
alt-R right-click, Run Run file/program with parameters.
alt-F4 double-click 

system box
Close a window or exit SWD.

ctrl-enter Open selected file, application or directory in the same 
window.

ctrl-<letter> double-click
disk drive icon

Open root directory of disk drive <letter>.

ctrl-tab Goto next SWD window.
ctrl-shift-tab Goto previous SWD window.
system menu | 
Menu | Copy

click-drag Copy or Move the item to another location, or drop on 
some application.

click-draw Click on window background & drag around items to select
the items falling within the drawn area. See shift-click, 
shift-spacebar, shift-arrow keys.

system menu | 
Menu | Alias

alt-drag Create an alias of a file or directory.

system menu | alt-double-click Bring up Properties for the item.



Properties
system menu | 
Menu | Copy

ctrl-drag Forces a copy from one directory to another. See click-
drag.

Windows
system menu | 
Menu | Refresh

double-click 
background

Refresh the window. This re-examines the disk directory to update 
any changes that may have happened.




